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Ühiskonnaõpetus 9. klassile – Töölehed


	UURIMISTÖÖ KOOSTAMINE

	Teema:
	Uurimistöö

	Klass:
	IX 

	Õpilane peab teadma ja oskama: 
	Teab uurimistöö koostamise algtõdesid; oskab kavandada, luua ja esitleda korrektselt vormistatud sisukaid tekste, esitlusi, uurimusi; oskab koostada ja vormistada referaati; oskab kasutada teatmeteoseid ja internetti infoallikana

	Põhimõisted
	Uurimistöö, uurimus, uuring, referaat, essee, viitamine

	Õppematerjalid ja 

kasulikud viited:
	 Soovitusi uurimistöö koostamiseks, Uurimustöö kui õppimise moodus, Uurimistöö juhend, Uurimistööde koostamise ja vormistamise juhend


NB! Sisujuhi ja alajaotuste pealkirjad toimivad linkidena!

SISUJUHT
11. Uurimistööst


32. Uurimistöö teaduslikkus.


33. Uurimistöö koostamise protsess


34. Teema valik.


45. Töö eesmärk, ülesanded ja hüpotees.


     5Uurimusliku töö koostamise etapid


66. Töö põhiosad ja nende vormistamise nõuded.


87. Viitamine (e. allikate näitamine) ja bibliograafilised kirjed.


108. Tabelite ja jooniste vormistamine.


109. Soovitusi vormistamiseks.


1110. Ettevalmistus töö avalikuks tutvustuseks, kaitsmiseks.


1210.1. Esinemise struktuur:


1210.2. Esitluse näitlikustamine


1210.3. Tehniliste vahendite kasutamise eesmärgid


1210.4. Efektiivse slaidi kujundamine


1410.5. Posterettekanne


1511. Arvutil vormistamine.


1511.1. Lehe formaat ja teksti paigutus.


1511.2. Teksti liigendamine


1611.3. Sisukorra loomine ja pealkirjade vormistamine


1711.4. Viidete sisestamine arvutil


1811.5. Tabelite, skeemide, jooniste ja graafikute koostamine.


2112. Näpunäiteid tekstitöötluseks


2213. Juhendaja ja retsensendi rollist


2314. Materjale uurimistööde kohta:




 1. Uurimistööst
Uurimistöö on:

1) uurimusliku protsessi konkreetne tulemus- kirjalik aruanne sellest, mida uuriti, kuidas uuriti ning millised on järeldused ja tulemused, milleni töö käigus jõuti;

2) protsess ja töömeetod, mille käigus analüüsitakse uuritavat probleemi süstematiseeritud ja asjakohaselt struktureeritud viisil.

Uuring- lühiajaline v. ühekordne andmete kogumine, piiratud mahuga uurimisülesanne.
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Uurimus- trükis ilmunud v. kirjalik uurimistöö.

Kodu-uurimistöö- on uurimuslik töö, mille temaatikaks on oma kodukandi v. mõne muu piirkonna(nii ajaloo kui tänapäeva, loodus- kui inimkeskkonna)  uurimine.

Referaat on kellegi teise seisukohtade esitamine, sisukokkuvõtte või ülevaade mingist tööst (töödest); kirjalike materjalide läbitöötamise tulemusena koostatud kirjalik kokkuvõte, mis väljendab teiste mõtteid

Essee- lühike probleemirikas kirjutis, probleemkirjutis, vabas vormis mõttearendus mingil konkreetsel teemal. Essee koosneb kolmest peamisest osast: sissejuhatus, teema arendus ja lõpetus. Essee kui teaduskirjandi oluline struktuurielement on probleem, mis sõnastatakse sissejuhatuses selgelt ja täpselt ning millele antakse kokkuvõttes ka vastus. Essee eesmärgiks on esitada mingi väide (väited, mitte üle kolme) ning seejärel seda sobivate argumentidega tõestada, tuues ära nii poolt kui vastuargumendid. Essee võib sisaldada ka teiste mõtteid, mida koostaja seostab iseenda seisukohtadega.

Uurimistöö ei tohi alla plagiaat (kellegi uurimistööst seisukohtade sõnasõnaline mahakirjutamine allikale viitamata, loomevargus). Uurimistöös võib kasutada uuritavat probleemi käsitlevaid refereeringuid erinevatelt autoritelt, kuid nende võrdlemise ja analüüsi käigus tuleb jõuda omapoolsete järeldusteni. Uurimistöö peab näitama õpilase iseseisva mõtlemise võimet veel uurimata (või väheuuritud) materjalide analüüsil ja argumenteeritud teksti koostamise oskust.

Uurimusi võib koostada kolmel tasemel:

· kirjeldav uurimus; 

· kahe nähtuse vaheliste seoste uurimine; 

· probleemi põhjuste analüüsimine. 

Uurimistöid võib jaotada kahte liiki: teoreetilised (e. ülevaated, nn. review) ja  eksperimentaalsed (e. uurimused, nn. case study). Teoreetilistes töödes antakse kirjanduse põhjal ülevaade uurimisprobleemiga tegelemise seisust, üldistatakse senisaavutatut ja näidatakse edasise uurimise võimalusi. Uurimuste korral kogutakse mingile probleemile vastuse leidmiseks andmeid, analüüsitakse neid ja esitatakse järeldused. 

Ülesehituse alusel võib eristada nn. väitekirjapõhiseid ja artiklipõhiseid uurimistöid. 

Artiklipõhine töö on ülesehitatud sarnaselt teadusartiklile ja koosneb järgmistest osadest:

a) lühiülevaade tööst (eesmärk, kasutatud metoodika, põhilised tulemused ja järeldused);

b) sissejuhatus (probleemi taust, eesmärgid ja ülesanded, hüpotees);

c) materjal ja metoodika (uuringu korraldus, kasutatud meetodite ja protseduuride kirjeldus;

d) tulemused- töö käigus kogutud andmed töödeldud kujul, tabelid, skeemid, joonised jms.

e) arutelu e. diskussioon- tulemuste tõlgendamine, võrdlemine seniteatuga, ettepanekud edasiseks uurimiseks;

f) kasutatud materjalide bibliograafilised kirjed.

Väitekirjapõhine uurimistöö koosneb selgelt eraldatud struktuuriühikutest: tiitelleht, sisukord, sissejuhatus, peatükid, kokkuvõte, kasutatud kirjandus jne. Vt. töö põhiosad.
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NB! Uurimistöö on kirjutatud lugejale, see vahendab teadmisi, mida on töö käigus omandatud ja mida nüüd tahetakse teistele teatavaks teha. Algusesse
2. Uurimistöö teaduslikkus.
Teadustöö eesmärgiks on uute teadmiste saamine ja nende rakendamine ning sellest tulenevalt on teaduslikkuse tähtsaimaks tunnuseks originaalsus- tulemuste uudsus, algupärasus, esmakordsus. Teadustöö peaks sisaldama esmakordselt saadud tulemust, uudset probleemi lahendusteed, originaalset seletust vms. Igal teadusharul on oma mõisted, seaduspärasused ja uurimismeetodid. Teadustöö juurde kuulub ka autoriteetide seisukohtade ja varasemate uurimuste analüüs, kuid kõik see, mis töös pole autori oma, vaid on võetud teistelt autoritelt, peab olema viidatud. Järelikult peab  töö koostaja olema uuritava valdkonnaga hästi kursis. 

Teaduslikku tööd iseloomustab ka objektiivsus, st. autor peab käsitletavasse teemasse või probleemi suhtuma võimalikult erapooletult ja allikakriitiliselt. Töös toodud väited peavad olema küllaldaselt tõestatud (argumenteeritud, põhjendatud) ja kontrollitavad, töö peab olema plaanipärane ja süsteemikindel. 

Kuna õpilase jaoks on uurimistöö esimeseks kokkupuuteks teadustööga, siis tuleb esmatähtsaks pidada siiski kogemuste omandamist, mitte aga niivõrd tõsiteaduslikkust. Teaduslikkuse järgimine eeldab ka kolme sisuliselt eristuva osa olemasolu töös:

a) ülevaade sellest, mida teised on teinud;

b) ülevaade oma uurimuse tulemustest ja kasutatud meetoditest;

c) enda tulemuste võrdlus teiste omadega ning järeldused.

3. Uurimistöö koostamise protsess
1) õpilane valib valdkonna või õppeaine, milles teha uurimus;

2) õpilane koos juhendajaga valib esialgse teema;

3) õpilane tutvub juhendaja poolt soovitatud kirjandusega;

4) õpilane sõnastab juhendaja abiga probleemi;

5) õpilane koostab koos juhendajaga töö plaani;

6) õpilane vormistab uurimuse uurimistööna;

7) õpilane esitleb töö tulemusi.

4. Teema valik.
Uurimistöö aluseks on ühte lausesse mahutatav idee. Idee otsimine on loominguline protsess, seetõttu on sobiva teema leidmiseks v. sõnastamiseks vajalik juhendajaga põhjalikult nõu pidada. Teema valikut tuleb ka põhjendada lugejatele.

Teema peab olema konkreetne, kuigi tööd alustades võib see olla sõnastatud laiemalt, ent töö käigus seda järk-järgult piiritletakse kuni sõnastatakse juhtmotiiv (põhiprobleem). Uurimuslik töö on suunatud probleemile, eesmärgiks on leida vastus probleemile.

Teema täpset sõnastamist aitab: 

1) huvipakkuva valdkonna täpne määratlemine;

2) uuritavas valdkonnas küsimus(t)e sõnastamine, millele tahetakse saada vastust. See küsimus tuleb sõnastada uurimisprobleemina, millele vastamine peaks andma uue teadmise. Uurimisprobleem sisaldab juba tuntut ja seda, mida veel ei tea;
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soovitav on panna kirja hulk küsimusi ja oletusi sõnastatud uurimisprobleemi kohta ning seejärel valida nende hulgast uurimist väärivaim. 

Teema lõplikuks sõnastamiseks tuleb tutvuda erialakirjandusega, selgitamaks kas keegi pole juba sama probleemiga tegelenud. Enne tööle asumist on soovitav enda jaoks läbi mõelda vastused järgmistele küsimustele:

· Kas see teema huvitab mind?

· Milles seisneb selle teema uudsus, rakenduslik tähendus?

· Kas on piisavalt teemakohast materjali?

· Missugused on minu ajalised ja materiaalsed võimalused?

· Kas selle teemaga tegelemine arendab mind, võimaldab mul näidata oma teadmisi ja oskusi?

· Millistele küsimustele ma otsin vastust?

· Mis on minu uurimuse mõte, milleks ma seda teen?

5. Töö eesmärk, ülesanded ja hüpotees. 
Teema fikseerimise järel sõnastatakse töö eesmärk. Eesmärk näitab, milleni tahetakse lõpuks välja jõuda. Konkreetsed ülesanded on nö vahendid, teed, viisid, kuidas eesmärgile jõutakse. Probleemi lahendamine eeldab teoreetiliselt või empiiriliselt kontrollitava hüpoteesi püstitamist. Hüpotees on teaduslik oletus, uurimuse jaoks on see testitav seisukoht. Hüpotees kujuneb välja kui üks (kõige tõenäolisem) probleemi võimalikke lahendusi. Hüpotees sisaldab tõestamata, oletuslikke väiteid, on loogiline konstruktsioon. Hüpotees tuleb uurijal endal välja mõelda. See on loominguline töö. Hüpoteesi on vaja, sest: 

· hüpotees annab uurimistegevusele kindla suuna; 

· hästi formuleeritud hüpotees väldib uurimistöös laialivalguvust; 

· hüpotees suunab uurija mõtet ning annab kindlamad raamid tööks vajaliku materjali kogumisele. 


Hea hüpotees on selline, mille vahendusel on võimalik teha teaduses samm (olgugi õige väike) edasi. Hüpoteesis sisalduv oletus on probleemis püstitatud küsimuse vastus.

Hüpotees on seega tõenäosuslik ja peab olema kontrollitav. Hüpoteesi kontrollimine seisneb selles, et temast kui loogilisest eeldusest tuletatakse järeldused, mida saab põhimõtteliselt kontrollida. Uurimuse algfaasis võib esialgseks orienteerumiseks püstitada mitmeid tööhüpoteese. 

Hüpoteesi kontrollimiseks vajame fakte. Fakt ise pole veel vastus küsimusele, kas hüpotees on kehtiv. Fakt on alus hüpoteesi hindamisel. Mida suurem hulk fakte räägib hüpoteesi poolt, seda tõepärasem on hüpotees. Hüpoteesi kummutamiseks piisab aga mõnest vastuolus olevast faktist, st., et faktide tõestusjõud hüpoteesi suhtes on väiksem nende ümberlükkavast jõust. 

Kirjeldavates töödes hüpoteese siiski tavaliselt ei püstitata, samuti ei ole vaja ka igasugust probleemi lahendusena pakutavat oletust hüpoteesiks nimetada. 
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Algusesse.
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Uurimusliku töö koostamise etapid
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6. Töö põhiosad ja nende vormistamise nõuded.
I Tiitelleht järgmiste andmetega: õppeasutuse täielik nimetus, töö pealkiri, töö iseloom (uurimistöö, referaat vmt), koostaja ees- ja perekonnanimi ning klass, juhendaja ees- ja perekonnanimi, töö valmimise koht ja aasta.
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Tiitellehe näidis

II Sisukord kirjeldab töö struktuuri, sisaldab iga alaosa täpse pealkirja ja vastava lehekülje numbri.

Sisukord on töö alguses, tiitellehe järel. Sisukorras on kõik töö jaotised selles järjekorras, sõnastuses ja numeratsiooniga, nagu need esinevad töös endas.

Töö lihtsustamiseks saab sisukorra loomise pealkirjade nummerdamise jätta arvuti hooleks. 

Sisukorra, sissejuhatuse, samuti kokkuvõtte ja kasutatud kirjanduse ette jaotise numbrit ei kirjutata. Lisa loetletakse sisukorras ühekaupa. Iga peatükk algab uuelt leheküljelt. Kõik leheküljed, sealhulgas kirjanduse loetelu ja lisad, nummerdatakse ühtsesse numeratsiooni. Esimene on tiitelleht, millele numbrit ei kirjutata. Lehekülje numbrit ei kirjutata ka sisukorrale, mida alustatakse põhijaotise pealkirjaga. Vt. kuidas teha arvutil.
Sisukorra näidis

SISUKORD


SISSEJUHATUS .....................................................................................…….
  4

1.  ESIMESE PEATÜKI PEALKIRI (suurte tähtedega) ................... .......…..
  5

1.1.  Esimese peatüki esimese jaotise pealkiri ......................... ......…
  5

1.2.  Esimese peatüki teise jaotise pealkiri ............................... .....…
  8
2.  TEISE PEATÜKI PEALKIRI (suurte tähtedega) ...............................……
10

2.1.  Teise peatüki esimese jaotise pealkiri ............................... ....…
10

2.2.  Teise peatüki teise jaotise pealkiri .........................................… 
14
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Teise peatüki teise jaotise esimese alljaotise pealkiri ..... 
16


KOKKUVÕTE .........................................................................................…… 
20

KASUTATUD KIRJANDUS ..................................................................... …
22


LISAD



Lisa 1 pealkiri ................................................................................…. 
23



Lisa 2 pealkiri ................................................................................…. 
24

III Sissejuhatus sisaldab:

· teema valiku põhjendus (miks valisid selle teema, miks see huvitas, milles seisneb selle aktuaalsus)

· töö eesmärgi (juhtmotiivi, põhiprobleemi) sõnastamine 

· ülevaade kasutatud uurimismetoodikast ja meetoditest

· ülevaade peamistest allikatest

· ülevaade töö struktuurist ja alaosadeks jaotamise põhimõtetest 

Heaks tooniks on ka kõigi töö valmimisele kaasa aidanud isikute tänamine sissejuhatuses.

Soovitav on sissejuhatus lõplikult viimistleda kõige viimasena.

IV Põhiosa peatükkidena sisaldab:

· probleemi seletava kirjelduse;

· probleemi analüüsi;

· tulemuste esitamise.

Töö sisulises osas antakse vastused sissejuhatuses tõstatatud küsimustele, samuti peab olema selgesti välja toodud õpilase isiklik panus ja käsitletud autorite seisukohad. Probleemile vastuse otsimise käigus tuleb püstitada uurimiskõlbulikud hüpoteesid, mille mõisted on üheselt tõlgendatavad ja mõistetavad.

Teema loogilise arenduse seisukohalt oluliseks peetud tsitaatidele ja refereeringutele tuleb lisada töö autori kommentaarid. Tsitaat peab olema täpne ja vastama originaalile. Tsitaadi algusest, keskelt või lõpust ärajäetud sõnade asemele pannakse mõttepunktid. Refereerimine on teise autori või allika sisu konspekteeriv või kommenteeriv esitamine oma töös. Refereeringu esitusest peab selguma, missugused mõtted kuuluvad refereeritavale autorile ja kust algavad töö autori kommentaarid (tsitaat pannakse jutumärkidesse).

Põhiosa tekstis on põhijaotised (peatükk või paragrahv) ja alljaotised (punkt, alapunkt, lõige). Peatükkide pealkirjad kirjutatakse tavaliselt suurte tähtedega. Põhijaotised nummerdatakse araabia numbritega ühest alates. Iga põhijaotise sees nummerdatakse samal viisil, jättes tähise sisse ka põhijaotise numbri. Esimese astme alljaotise sees alustatakse jälle uut nummerdust jne. Numbrite vahel ja tähise lõpus (jaotise alguses) on punkt. Kui tähisele osutatakse tekstis, siis selle lõpus punkti ei ole (nt punkti 2.3.2 kohaselt)

V Kokkuvõte on vastus sissejuhatus püstitatud probleemile (hea kokkuvõte võimaldab lugejal põhiteksti vahele jättes ikkagi aru saada, mida töös on käsitletud): lühidalt ja süstematiseeritult esitatakse kõige olulisemad järeldused, milleni töö käigus jõuti. Samuti kirjeldatakse ka tekkinud ja edaspidist uurimist vajavaid probleeme, kuid uusi andmeid enam ei esitata.
VI Kasutatud materjalide loetelu peab sisaldama kõiki allikaid, mida antud töö käigus kasutati ja millele on viidatud. Kasutatud allikate ja kirjanduse loetelu põhjal saab asjatundja otsustada kuivõrd pädev on töö autor antud temaatikas ja kas selles ka midagi uut võib leida.

Kui on kasutatud mitut liiki allikaid, tuleks need ka vastavalt eristada:

1) kirjalikud allikad (arhiivimaterjalid, käsikirjalised materjalid, kirjavahetus,  perioodika, internet);

2) suulised allikad (mälestused, intervjuud, video- ja audiomaterjalid)

3) kasutatud kirjandus.

VII Lisad sisaldavad tavaliselt materjali mida on töö eesmärkide saavutamiseks vaja läinud, kuid mis töö sisuga ei ole nii otseselt seotud (n. küsitluslehed, suuremad plaanid ja kaardid, mõõtmisprotokollid jms). Samuti paigutatakse siia ka illustreeriv lisamaterjal (dokumendi v. fotokoopiad). 

Lisad nummerdatakse iseseisvalt (paremale ülanurka LISA 1) ja pealkirjastatakse, fotod allkirjastatakse (kes v. mis on fotol, millal ja kelle poolt jäädvustatud, kelle omanduses on originaal jms). Lisadele tuleb põhitekstis viidata.

VIII Resümee e. ülevaade tööst (max 1 lk.), milles esitatakse peamised mõtted ja järeldused, millest on töös juttu. Samuti võib esitada olulisemad märksõnad. Kuna resümee eesmärgiks on töö olulisemate tulemuste lühitutvustus, siis võib neid lähtuvalt töö väljundist koostada nii eesti- kui võõrkeeltes. Resümee paigutatakse kas sisukorra ette v. töö lõppu. Vajadus resümee järele võib tuleneda teatud konkursijuhenditest v. tööde lühiülevaadete kirjastamisel.

Algusesse
7. Viitamine (e. allikate näitamine) ja bibliograafilised kirjed.
Kõik töös esitatavad seisukohad ja andmed, mis pärinevad kasutatud materjalidest, tuleb siduda viidetega vastavatele allikatele(näidatakse koht, kust andmed pärinevad) e. teisisõnu- igal laenatud mõttel peab olema viide selle autorile. Viidata ei ole vaja üldtuntud seisukohtadele.  Viitamine on vajalik ka selleks, et lugeja saaks vajaduse korral kirjapandut allikate järgi kontrollida.

Kuna erinevad teadusalad kasutavad erinevaid viitamissüsteeme, siis tuleb töö koostajal lähtuda eelkõige oma kooli uurimistööde vormistamise v. vastava konkursi juhendist v. lähtuda vastava valdkonna teadusartiklites kasutatavast süsteemist.
Viitamise põhireegel: viitamissüsteem peab kogu uurimistöö ulatuses olema ühtne. 

Kõik kasutatud allikad peavad leiduma viidetes. Niisamuti peavad kõik kasutatud kirjanduse loetelus olevad allikad olema viidetes märgitud.

Tekstis viidatakse kas samal leheküljel joone all, tähistades viite tärniga (numbriga), või teksti sees sulgudes. 

7.1. Joonealune viitamine: tsitaadi või refereeringu lõppu märgitakse viite number, kusjuures viidete numeratsioon võib olla kas kogu tööd (peatükki) läbiv  või ühe lehekülje ulatuses. Joone alla lehekülje allserval märgitakse allika nimetus esmakordsel mainimisel täies ulatuses (nii nagu kirjanduse loetelus), järgmistel kordadel lühendina. Vt. kuidas teha arvutil.
7.2. Tekstisisene viitamine on otstarbekas tööde puhul, kus viiteid on suhteliselt rohkesti ning sel juhul on ka muudatuste/täienduste tegemine viidete osas tunduvalt lihtsam.

Lihtsaim võimalus on märkida vastava lõigu järel sulgudesse viidatava allika järjekorranumber kasutatud materjalide loetelus ja seejärel lehekülje number, kust andmed pärinevad: n. (11, 34).

Teine võimalus on märkida sulgudes autori nimi ja väljaande aasta ning viidatav lehekülg- näit.: (Vahtre 1994, 151).

Samasugust viitamissüsteemi kasutatakse ka nurksulgudega- allika number ja lk. number: [ 17, lk.7-8] 

 Kirjanduse loetelus esitatakse järgmised andmed: 

Autor (v. koostaja)- perekonnanimi, initsiaal.

Pealkiri (vastavalt tiitellehele)

Köide, osa, number.

Ilmumiskoht, kirjastus.

Ilmumisaasta

Lehekülgede arv.

Näited:

a) raamat: Vahtre, L. Eesti kultuuri ajalugu. Tln.: Jaan Tõnissoni Instituudi Kirjastus, 1994. 230 lk.

b) artikkel ajakirjast: Laar, M. Eesti sõduritest II maailmasõjas // Vikerkaar. 1991. Nr.6. Lk. 56-66.

c) Artikkel ajalehest: Mihkelson, I. Raemuusikat hea maitsega kuulajale // Postimees. 2000. 11. august.

Suuliste allikate loetelu:

Näit.:  Pensionär Johannes Paju (s. 1914, elukoht … )mälestused (kirja pandud …a. töö autori poolt).

Viites piisab: J.Paju mälestused.

Arhiivimaterjalide loetelu peab sisaldama järgmisi kirjeid:

Arhiivi ametlik nimetus, fondi (f) number, nimistu (n) number, säiliku (s) number:

ERA. F. 957. N.17. S. 3. Viitamisel lisandub  veel arhiividokumendi lehe (l) number:

ERA. F. 957. N.17. S. 3. L. 9-11.

Seadusandlike aktide loetelu:

Normatiivmaterjalide, nt õigusaktide loetelus antakse kõigepealt akti nimetus, siis akti vastuvõtmise aeg ja allikas, milles akt ametlikult on avaldatud. 
Näit.: 

Riigisaladuse seadus.  - RT I 1999, 16, 271.

Põhikooli ja gümnaasiumi lõpueksamite korraldamise ning põhikooli ja gümnaasiumi lõpetamise tingimused ja kord. Haridusministeeriumi määrus nr 75, 24.12.2001 // RTL, 2002, 3, 28.  
Interneti materjalide loetelu:

Autori nimi, Initsiaal. Artikli pealkiri. URL-aadress (http:// www. xxx.ee .kuupäev)

Kui autorit ei ole võimalik tuvastada, siis näidatakse aadress koos kõigi kirjete ja materjali hankimise kuupäevaga).

Näit.:

Burka, L. P.  A hypertext  history of multi-user dimensions. MUD history. 1993.  http://www.utopia.com/ talent/ lpb/muddex/essay (2 Aug. 1996).

Vestluslistide ja e-maili allikatele viitamisel võib autori nime puudumisel viidata ka nn. hüüdnimele, kindlasti tuleks lisada sõnumi saamise v. listi külastamise kuupäev. 

Näit.: Crump, E. Re: Preserving Writing. Alliance for Computers and Writing listserv. acw-l@unicorn. acs.ttu.edu  (31 Mar. 1995).

Algusesse
8. Tabelite ja jooniste vormistamine.
Kõik tabelid peavad olema pealkirjastatud ja nummerdatud (Tabel 1, jne) kas tööd läbiva või peatükisisese numeratsiooniga. Kui tabelis olevad andmed on pärit teatmekirjandusest, siis tuleb tabeli all neile ka viidata. Tabeli pealkiri ja number kirjutatakse enne tabelit, joonise number ja pealkiri aga joonise alla.
Ka joonised (s.h. diagrammid, skeemid, kaardid) pealkirjastatakse ja nummerdatakse (Joonis 1, jne). Igale joonisele ja tabelile tuleb tekstis ka viidata. Tabelid ja joonised on tekstile selgituseks, aitavad selle sisu paremini edasi anda. Algandmeid sisaldavad suuremahulised tabelid esitatakse tavaliselt töö lisas. Vt. kuidas teha arvutil.
Näited:

    Joonis 1. Välismaised investeeringud ühe elaniku kohta 1998.a.

                   (allikas: Eesti Välisinvesteeringute Agentuur)

      Tabel 1
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Riigid  (1997)

inimarengu indeksi alusel

Eeldatav eluiga

 Kirjaoskus(%)

SKP 1 elaniku kohta(USD) 

1. Kanada

79.0

99

22480

2. Norra

78.1

99

24450

3. USA

76.7

99

29010

13. Soome

76.8

99

20150

54. Eesti

68.7

99

5240

62. Leedu

69.9

99

4220

71. Venemaa

66.6

99

4370

74. Läti

68.4

99

3940

174. Sierra Leone

37.2

33

410


9. Soovitusi vormistamiseks.
1. Uurimistööd esitatakse valgel paberil formaadiga A4 (210* 297 mm) kas köidetult v. kiirköitjas.

2. Trükitakse soovitavalt intervalliga 1,5 vaid lehe ühele poolele, eelistatav šrifti suurus 12.

3. Leheküljele jäetakse vasakule ja üles 3-4 cm, paremale 1-2 cm laiune vaba äär, alumine äär on samas mõõdus ülemisega v. kasutatakse joonealuseks viitamiseks (arvutil vaikimisi vasakul ja paremal 3,17 cm, üla-ja alaserval 2,54 cm). Vt. kuidas teha arvutil.

4. Töö põhiosad algavad uuelt leheküljelt, vastava lehe ülaosa jäetakse 5 cm ulatuses tühjaks. Kui alapealkirjaga samale lehele ei mahu vähemalt kaks rida teksti, siis alustatakse uut osa järgmiselt lehelt.

5. Pealkirjades sõnu ei poolitata, ei kasutata lühendeid, lõppu ei panda punkti.

6. Taandrea kasutamine arvutitrükis ei ole kohustuslik, lõikude eraldamiseks kasutatakse tühja rida. Vt. kuidas teha arvutil.
7. Uurimistööd vormistades tuleb kinni pidada kehtestatud nõuetest (õppeasutuse juhendid).

8. Kõik lehed (alates tiitellehest) tuleb nummerdada, numbrid kirjutatakse lehekülgedele alates sissejuhatuse teisest leheküljest (arvutitrükis ei trükita numbrit ainult tiitellehele).

9. Töö ees ja taga peab olema puhas nn. köiteleht.

10. Tsitaatidel ja refereeringutel peavad olema täpsed viited.

11. Kasutatud materjalidele viitamisel tuleb kasutada ühtset süsteemi.

12.  Soovitav on ühekohalised numbrid (0-9) kirjutada tekstis sõnadega (kui pole taga ühikut), arvudele käändelõppe ei lisata.

13.  Tekstis pole soovitav kasutada üle 3-4 tüvenumbriga arve (näit. 13 700 asemel  13,7 tuh.).

14.  Hoiduda mitme mõõtühiku üheaegsest kasutamisest (näit. 15,5 kr., mitte 15 kr.50 senti).

15. Pööra tähelepanu keelekasutusele:

· Igas lauses on üldjuhul vähemalt üks tegusõna

· Kasuta ühesugust ajavormi 

· Väldi liigseid kordusi

· Otsene kõne on selgem kui kaudne

· Mina-vormi võib kasutada, kuid sellega ei maksa liialdada

· Ära kasuta liiga pikki lauseid

· Kasuta arvuti õigekirjakontrolli vahendeid

  Arvutil vormistamisel:

· Iga kahe sõna vahele käib üks tühik.

· Kirjavahemärkide ette tühikut ei jäeta, kirjavahemärgi järele pannakse üks tühik.

· Sulgude ja jutumärkide puhul sissepoole tühikuid ei käi, väljapoole käivad.

· Sidekriipsu ümber tühikuid ei käi, mõttekriipsu ümber käivad.

· Üldreeglina jäetakse arvu ja mõõtühiku vahele tühik, erandiks on protsendi, kraadi, nurgaminuti ja –sekundi tähis (n.18%, 6°  sooja); erandit ei kasutata kui tähis kuulub loogiliselt järgneva sümboli juurde (n.:  –8  °C).

· Arvväärtusi ei poolitata, arvuga seotud mõõtühikut ei viida üle teisele reale

10. Ettevalmistus töö avalikuks tutvustuseks, kaitsmiseks.
Töö tutvustamise ettevalmistamiseks peab esineja teadma:

· kuidas esineda

· kus esineda

· kellele esineda

Töö tutvustust võib alustada: definitsiooniga, viitega eeldatud teadmistele, üllatava faktiga, tsitaadiga, näidete seeriaga, statistilise materjaliga, naljaga, retoorilise küsimusega, viitega eelkõnelejale jms.

Esitluse lõpetamine: töös esitatud järelduste ülekordamine, retooriline küsimus, üleskutse uute lahenduste otsimisele.

10.1. Esinemise struktuur:

· Pöördu kuulajate poole
· Tutvusta ennast

· Ütle millest kavatsed rääkida

· Ütle kui kaua Sa sellest räägid

· Ütle, millal saab esitada küsimusi

· Edasta enda sõnum

· Ütle millest rääkisid

· Täna kuulajaid

· Palu esitada küsimusi
Algusesse.
10.2. Esitluse näitlikustamine

Esitluse näitlikustamise ülesandeks on ilmestada  ja mitmekesistada tutvustust. Näitvahendid peavad olema korrektsed, arusaadavad ja esitlusega otseselt seotud. 

Töö tutvustuse võib üles ehitada teesidena. Kindlasti tuleb rõhutada uuritud probleemi ja töö eesmärki, tutvustada kasutatud meetodeid ning tuua välja olulisemad tulemused, kindlasti tuleb vastata ka retsensendi poolt välja toodud probleemidele.

Algusesse.
10.3. Tehniliste vahendite kasutamise eesmärgid

Kasuta tehnilisi vahendeid selleks, et :

· Koondada kuulajate tähelepanu

· Rõhutada suulist sõnumit

· Suurendada kuulajate huvi

· Illustreerida ettekannet

Ära kasuta tehnikat selleks, et

· Avaldada kuulajatele muljet eriti detailsete andmetega

· Vältida kontakti kuulajatega

· Esitada korraga rohkem kui ühte tähelepanu nõudvat objekti

· Esitada lihtsaid mõtteid, mida on võimalik ka suuliselt esitada 

Järgi KISS printsiipi- keep it short and simple!

Algusesse.
10.4. Efektiivse slaidi kujundamine

Slaidide kujundamiseks arvutil on enimkasutatavaks programm MS PowerPoint. Juhtnööre Powerpoint 2000 kasutamiseks leiate: PowerPoint 2000, Powerpointi juhend.

Esitlustarkvara õppematerjale. Üha enam leiab kasutamist ka tasuta saada olev vabavara OpenOffice, mille komplekti kuulub ka slaidide kujundamise programm “Esitlus” (vaata juhiseid).

NB! Eesmärgiks ei ole mitte võimalikult rohkete andmete esitamine või slaidi pinna täitmine, vaid kuulajate huvi ja arusaamise suurendamine!

· Üks slaid -  üks põhiidee- üks eesmärk. 

· Kõik esitluses olev (taust, illustratsioonid, tekst) peab olema vastavuses teemaga.

· Ühel slaidil maksimaalselt 6 rida teksti, ühes reas maksimaalselt 6 sõna; tabeli puhul ühel slaidil maksimaalselt 30 arvu. 

· "Burma habemeajamise reegel" - mitte tuua silme ette enamat kui te suudaksite kiirteel täis kiirusega kihutades mingilt reklaamilt tähele panna. 

· Peakirja optimaalne suurus 32-72 punkti, tekstil 28 punkti (arvestada kuulajate kaugusega ekraanist).

· Valida kirjatüüp loetavuse seisukohast, mida on hea lugeda ja vältida uudseid ning "põnevaid" tüüpe, ühel slaidil üks stiil. 

· Vältida täiesti suurtähtedes kirja.

· Vasakpoolse joondusega tekst on kõige paremini loetav.

·  Kasutada mõõdukalt animatsioone ja slaidide vaheldumise efekte, mis vastasel juhul hõivavad kogu vaatajate tähelepanu. 

· Reegel on lihtsus. See, et me oskame, ei tähenda veel seda, et me peame.

· Ühel slaidil mitte üle ühe illustratsiooni.

· Slaidile lisada ka koostaja nimi ja koostamise aeg
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Joonis 2. Slaidi näidis

Algusesse.

10.5. Posterettekanne 

on ettekande vorm, mille abil presenteeritakse oma tööd. Vormilt on see  suureformaadiline paber, teksti ja piltidega. Väga oluline on teksti välispilt: see peab olema hästi liigendatud lõikudeks, ilma keeruliste graafiliste kujundite ning liigsete detailideta. Oluline on ka pealkirjade ja alapealkirjade kujundus. Posterettekande alguses defineeritakse probleem, seejärel eesmärgid, järeldused, uurimuse tulemused,  lõppsõna.

Poster on esitlemise vahend. Poster peaks koosnema üksikutest suurematest blokkidest, kuid kasutatavad laused ei tohi väga pikad olla. Posterettekande köitvuse, loetavuse ja mõistmise seisukohalt peab see olema visuaalselt tähelepanu tõmbav ja kiirelt loetav, kiri olema küllalt suurus ja nähtav.
Ettekande esitleja seisab üldjuhul oma posterettekande kõrval, et oleks võimalik saada täpsustusi või diskussiooni arendada. Teadusliku posteri eesmärk on esitleda tööd auditooriumile, kes võib ruumis ringi liikuda. Poster võib toetada konkreetset ettekannet, aga võib olla koostatud ka eraldivaadeldavana.










Joonis 3. Posterettekande näidis

Algusesse.


11. Arvutil vormistamine.

11.1. Lehe formaat ja teksti paigutus.

Paberi formaadi määramiseks arvuti tekstitöötlusprogrammis vali menüüribalt File - Page Setup ning avanenud dialoogiaknas vahelehelt Paper Size määra formaadiks A4.

Lehe servade suuruse määramiseks vali menüüribalt File - Page Setup ning avanenud dialoogiaknas vali vahelehelt Margins sobivad lehekülje servade suurused.
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Joonis 4. Lehe formaat ja teksti paigutus

Algusesse
11.2. Teksti liigendamine

Töö iseseisvad osad algavad uuelt lehelt. Vältimaks paigutuse muutusi töö täiendamise korral, võib peatüki lõppu määrata lehekülje vahetuse (Insert menüü →   Break→   Page Break).

Põhitekst jaguneb lõikudeks. Arvutiga vormistamisel ei ole vaja kasutada taandrida, lõike võib eraldada plokkidena, st laiema vahemikuga (6 pt). Lõigu lõpus tuleb vajutada  Enter klahvile ning Format→ Paragraph→ Spacing: after 6 pt. saadakse märgitud alal lõikudele laiemad vahed. 




Joonis 5. Lõikude ja reavahe määramine

Algusesse
11.3. Sisukorra loomine ja pealkirjade vormistamine

Sisukorda on kõige lihtsam vormistada põhiosa valmimise järel arvuti abil valides menüüst INSERT Index and Tables alljaotuse Table of contents ning valige sobiv sisukorra kujundus.

Et sisukorda saaks luua peavad aga kõik pealkirjad olema vormistatud kindlas stiilis, olenevalt pealkirja astmest.
Pealkirja automaatseks nummerdamiseks tuleb Format menüüst valida Bullets and Numbering→ Outline Numbered  ja sealt valida vastav väli (vt. joonis).




Pealkirja vormistuse muutmiseks avage Style aken:  Format →Style ning seejärel valige loetelust pealkiri, mille kujundust muudate. Seejärel Modify ning avanenud menüüst uuesti Font ja tehke vajalikud muudatused (tähtede suurus, kirjatüüp, kõik suurtähtedena jms).
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Joonis 7. Pealkirjade stiili kujundamine

Algusesse

11.4. Viidete sisestamine arvutil

Joonealune viitamine
Tähistage vastav sõna või lause ning valige Insert→ Footnote.

*Valides Footnote paigutuvad viited vastava lehekülje jalusesse, valides Endnote paigutuvad viited vastava dokumendi lõppu.

Viite tähistuse juurde kirjutage vajalik kirje vastavalt viitamise nõuetele. 




11.5. Tabelite, skeemide, jooniste ja graafikute koostamine.

Tabelid ja joonised.

Lihtsamate tabelite loomiseks on Wordis võib valida Table→Insert→Table või klõpsates menüüribal olevale tabeli ikoonile (vt. joonis)
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Joonis 9. Tabeli loomine Wordis

Wordi tabelist diagrammi loomiseks tuleb vastav tabel märgistada ja valida menüüst Insert→Picture→Chart.  Loodud diagrammi kuju saab muuta tööriistaribal avanevate ikoonide abil.

Keerukamate tabelite ja diagrammide loomiseks on otstarbekas kasutada MS Exceli võimalusi.

Tulpdiagramm on ülevaatlikum, kui tahame võrrelda erinevate tunnuste sagedusi omavahel, sektordiagramm aga juhul , kui tahame näha iga üksiku tunnuse osa tervikus 
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Joonis 10. Tulpdiagrammi näidis

                             Tabel 2

      Riigieelarve tulud


[image: image7.wmf]tuluallikas

miljardit 

kr

sotsiaalmaks

13,95

käibemaks

10,49

tulumaks

5,05

aktsiisid

4,83

mittemaksulised 

tulud

3,84

muud

0,27











Joonis 12. Sektordiagrammi näidis

Algusesse
Skeemid

Skeemi koostamine “MS Organization Chart” abil:

1) Valige Insert menüüst Object

2) Create New aknast valige MS Organization Chart
· 

NB! MS PowerPointi programmil on Organization Chart’iga slaid võimalik valida ka uue slaidi loomisel.

            Joonis 13. Organization Charti sisestamine PowerPointis


3) Styles menüüst saate valida skeemile sobiva kuju, struktuuri osade lisamiseks tuleb valida vastav osa (manager, assistant, co-worker v. subordinate) ning klõpsata kastil millega uus osa peaks olema ühenduses.


Joonis 14. Skeemi stiili valik

4) Boxes menüüst valige skeemikastikestele sobiv värv ja raamistiil

5) Muudatuste tegemiseks skeemil, mis on sisestatud mõne teise programmi (Word, Excel, Powerpoint) faili, tehke sellel topeltklõps- seejärel avaneb MS Organizational Chart menüü. Muudatuste salvestamiseks valige File menüüst Update. Skeemi edasiseks kasutamiseks on otstarbekas see salvestada ka iseseisva failina (File menüüst Save Copy as) sobivasse kausta (folder).


Joonis 15. Skeemi näidis

Algusesse
Voodiagrammi koostamine MS Wordis

Voodiagramm on protsessi sammude piltlik esitus, mis näitab, kuidas protsess tegelikult toimub.

Kasutatakse:

1) olemasoleva protsessi kirjeldamisel;

2) uue protsessi kavandamisel;

3) protsessi erinevate astmete omavaheliste seoste uurimiseks.

Voodiagrammide abil on kerge ette valmistada nii suulisi ülevaateid kui ka illustreerida esinemisi, kus tuleb kirjeldada v. analüüsida v. kavandada mingit protsessi, samuti on need rakendatavad ka uurimuslike tööde teostamisel.

Voodiagrammi sümbolid on enimkasutatavatel programmidel menüüs “Autoshapes/ Flowchart”):


Protsess ( on vastastikku seotud mõjurite ja tegevuste koosmõju)


   Andmed (protsessis vajalikud lähteandmed)


   Dokument (mida kasutatakse protsessis)


Dokumendid 


Otsus/ valik (igast otsustusest peab väljuma vähemalt 2 suunda)


            Konnektor ( jätkukoht)








Algus/ lõpp( igal protsessil peab olema algus ja lõpp)

Voo suund 


Protsessi kirjeldamise sammud:

1) määratleda algus ja lõpp

2) määratleda protsessi sammud (tegevused, otsused)

3) koostada voodiagrammi kavand

Algusesse
12. Näpunäiteid tekstitöötluseks
Kommentaaride lisamine: arvutis koostatud tekstide täiendamiseks aga samuti ka märkuste tegemiseks v. küsimuste esitamiseks on lihtne kasutada “Insert Comments” teenust. 

1) Wordi dokumendis tähistage sõna v. lõik, millele soovite lisada kommentaari.

2) Insert menüüst valige Comments.

3) Tähistatud sõna v. lõik värvub ja selle kõrvale ilmub kood.

4) Ekraani allosas avaneb kommentaaride paneel koos sama koodiga: kirjutage kommentaar ja sulgege paneel.

5) Viige kursor kommenteeritud sõnale ning selle kohale ilmub eraldi ikoon koos kommentaariga.

Teksti redigeerimine: hea võimalus paranduste ja täienduste tegemiseks pakub “Track Changes”- teie poolt tehtud muudatused õpilastöös v. mustandis on seejärel kergesti eristatavad.

1) Enne muudatuste tegemist avage Tools menüüst Track Changes /Highlight Changes. 

2) Highlight Changes aknas tehke linnuke kõigisse kastikestesse (Track changes while editing- tagab muudatuste eristamise nende sisestamise ajal).

3) Tehke tekstis vajalikud muudatused ning need eristuvad teise värviga koheselt ka ekraanil.

Teksti ülesehituse organiseerimine: teksti lõikude, alapealkirjade ringipaigutusi ja muutusi on hõlpus teha Outline View abil.

1) Valige View menüüst Outline, avaneb uus tööriistariba. 

2) Üles- ja allapoole suunatud noolte abil on võimalik vahetada lõikude järjekorda

3) Paremale ja vasakule suunatud nooltega on võimalik korraldada ümber alalõike.

4) Tehes topeltklõpsu sõnal All, kaob tavaline tekst. Uuesti klõpsates ilmub see tagasi. Pikkade tekstide puhul võimaldab see kergesti teksti ümber korraldada.

5) Tavalise vaate juurde tagasipöördumiseks valige View menüüst Normal.  

Algusesse
13. Juhendaja ja retsensendi rollist

Juhendaja:

· aitab sõnastada töö eesmärki ja kavandada struktuuri

· annab metoodilisi nõuandeid, jälgib töö koostamise käiku

· nõustab teemakohase kirjanduse ja allikate otsimist

· abistab probleemide lahendamisel, konsulteerib regulaarselt

· selgitab uurimistöö sisule ja vormistusele esitatavaid nõudeid

· kontrollib töö valmimist osade kaupa ja tervikuna

· valmistab autorit ette töö kaitsmiseks

· hindab uurimistöö koostaja tegevust ja tema töö tulemust tervikuna

Retsensent peab:

· jälgima töö vastavust püstitatud eesmärgile

· andma töö iga osa täitmise iseloomustuse ja jälgima teaduse viimaste saavutuste kasutamise astet

· andma hinnangu püstitatud ülesande lahendamise otstarbekusele

· näitama töö kasutusvõimalusi

· jälgima vormistuse vastavust nõuetele

· välja tooma töö peamised väärtused ja huvipakkuvamad osad

· välja tooma töö puudused (viidates konkreetsele leheküljele, lõigule, reale v. joonisele)

· andma hinnangu tööle

· esitama retsensiooni töö koostajale enne töö kaitsmist.

14. Materjale uurimistööde kohta:
Kuidas teha uurimustööd: Praktilisi näpunäiteid algajale teadurile /Koostanud Maidu Varik // Kuressaare Gümnaasiumi Toimetised. 1994. Nr.1.

Kõverjalg, A. Üliõpilastööde koostamise metoodika. Sisekaitseakadeemia. Tln., 1999.

Leinus, M. Algteadmisi uurimistööst. Õppevahend põhikooli õpilastele. Tartu, 1997.

Luka, E. Soovitusi kodu-uurimistöö koostamiseks ja vormistamiseks // Õpilaste kodu-uurimistöid. Tln.: Eesti Noorsoo Algatuskeskus,  1996. Nr.18. Lk. 74-90.

Relve, K. Õpilaste bioloogiaalaste uurimistööde vormistamise juhend. Tln., 1992.

Interneti-materjale:

Soovitusi uurimistöö koostamiseks
Uurimustöö kui õppimise moodus 

Uurimistöö juhend

Uurimistööde koostamise ja vormistamise juhend

Joonis 6. Pealkirja vormindamine
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Joonis 8. Viite sisestamine
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